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This instruction guide shows the steps and processes in making a Kwawu 3.0 transradial prosthetic
arm and hand. This arm is best suited for a recipient with a residual forearm longer than half of the
recipient’s intact forearm. See the Socket version of the Kwawu 3.0 for an arm better suited for a
residual arm that is half or shorter than the recipient’s intact arm.

To complete the instructions in this document and fully prepare an arm for usage can take 30 to 40
hours of labor. Assuming most people reading this document are doing this project in their spare
time, expect it to take several weeks. Likely the first one you make may not fit or work exactly right,
when you try it on the recipient, so you will have to reprint a part and partially reassemble the arm. It
is important to set this expectation for yourself and the person you are making the arm for. Explain to
them and yourself that the whole process can take months.

Improvements of the Kwawu 3.0 over the Kwawu 2.0 device include:

Easier stringing the fingers to hand mechanism

Better response of elbow bend to finger squeeze

A locking but adjustable wrist

Improved latch mechanism to fix hand fingers in a grasped position
The Cuff and Forearm have plastic or leather options
Thermoforming is not required

A redesigned tensioner

Easier assembly

Compatible with wider range of TPU ShoreA hardness

Qualifying Expectations

This arm was designed by hobbyists in hopes that it would fill a need for someone who has had
a congenital or traumatic amputation. We do not claim to be professional prosthetists and this
arm is designed as an assistive device not a custom prosthetic. This was designed to be used
as an assist in everyday functional activities. These are step by step instructions for fabrication
of the arm. Our team is available to help problem solve and answer questions should you have
difficulties. If you are in need of this assistive device but are unable to make it or have it made
we are happy to assist with that as well. As hobbyists our goal is to help make an assistive
device which makes day to day activities a little easier.

This Process of making a Kwawu 3.0 Wrap Version is described in the
document and is divided into 3 sections, namely:

Section 1: Preparing Files for Printing.
Section 2: 3D Printing of the Necessary Parts

Section 3: Assembly of the Kwawu Arm 3.0 Wrap Version
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Section 1: Preparing files for printing

Overview

1.

»

Download the Kwawu 3.0 Wrap version from www.thingiverse.com. DO NOT print the stl files
directly—they will not result in a functional device—files must be translated into usable stl files
using the customizer in OpenSCAD.

Download the latest version of OpenSCAD from http://openscad.org/downloads.html Then open
the file “Kwawu 3.0- Wrap.scad.

Obtain required measurements from the recipient — Record values for the recipient in Table 1.
Fill in the OpenSCAD parameters with the specific values of the recipient’'s measurements.
Render all appropriate parts in the display and save the result as a file.

Download Kwawu 3.0 files

When you download the files from thingiverse there is one .scad file and a bunch of .STL files. DO
NOT print the STL files directly. The Open SCAD software will load the STLs and “modify “ them to fit
the recipient.

Download and Install OpenSCAD

1.

Download the latest version of OpenSCAD. http://openscad.org/downloads.html

Once you have installed OpenSCAD, click on “New” then in the top menu, select File>Open.
Browse and click on the file “Kwawu 3.0- Wrap.scad "

Uncheck ‘Hide Customizer’ in the View menu (as shown below) to show the Customizer Ul at the
right.


http://www.thingivers.com
http://openscad.org/downloads.html
http://openscad.org/downloads.html
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4. In the Customizer menu on the Right Hand side, click the little black arrow to display the
parameters. Make sure “Automatic Preview” and “Show Details” are both checked.

ﬂ' Cusiomnizer

B Automatic Preview Show Details [ Reset

no preset selected B i - e

= Paramepes

5. Hit the Preview button (F5) to get a quick preview (should not be necessary if ‘Automatic preview’
is enabled).

ﬂ' Exdir
fa] ™ s ﬂﬁﬁﬁ{@l@ﬂ

6. You should see a preview of the Cuff1 in the main window. It looks something like this.
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o

7. If the object is too large or small press the “View all” button
39 ®aaD s Ped g8 ko

The view will change to something like this.

'I T
Now you are ready to set all the sizing parameters. Once you have set all the parameters you will
need to render each part and save to an STL file.

Measuring Your Recipient

There are several measurements you will need from the recipient. The circumference measurements you
will want to make on the residual arm. The Forearm Length and Hand Width you will make on the intact

arm. All measurements are in millimeters.
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Measurements Diagram
Bicep Circumference: Measured around the upper arm at its thickest point. Measured on the
residual arm being fitted with the prosthesis.

Forearm Circumferences: This is a series of measurements meant to capture the shape of the
forearm socket. Starting at the recipient’s residual elbow crease, measure the forearm’s circumference.
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Forearm Length : This is measured from the elbow crease to the wrist crease on the recipient's
intact arm. Instead of inputting this value as the Forearm Length, we recommend a length a few
centimeters longer than the residual arm (leaving enough space for the wrist mechanism). A shorter
arm length is easier for maneuverability and better mechanical advantage. This “Kwawu 3.0 Wrap” design
is intended for recipients with residual arms almost as long as the intact arm.

Hand Width: Measured on the intact arm. The measurement is across the knuckles in millimeters.

Fill in the OpenSCAD Parameters

Once you have measurements from the recipient you will enter various parameters into the Customizer
Parameters side bar.

An example of an OpenSCAD Parameters section is shown below. Note that besides the measurements
from the recipient, there are other choices to be made as well. These are also described subsequently.
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In OpenSCAD, it may be easier to turn OFF Automatic Preview while entering parameters. Many of
these parts are slow to render so having the preview run while entering numbers can make the user
interface cumbersome.

E_ﬂ Crisdaml el
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Detailed information on choices is necessary to render parts to make printable stl files. All 3D parts
to be printed must be rendered using the selected choices matching the recipient’'s measurements
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and/or preferences. A description of these choices are listed below in order. Table 1 shows the
acceptable ranges of these choices and allows you to fill in specific values for your recipient

OpenSCAD Parameters

Part

These include all parts necessary to assemble a Kwawu3 wrap Arm. Choose each
of the 40 parts, one by one, then render and save each one.

Before rendering any parts, be sure all the other parameters are set to match the
recipient. Input or use the sliders to set the values. Uncheck “Automatic Preview”
if you have issues with inputting values. After rendering, go to File>Export>As
STL . Name the file to correspond to the part rendered and Save. See “Leather
or Plastic” for an exception in the export file choice.

Left or Right Arm

The side of the body for the prosthetic arm required by the recipient.

LeatherOrPlastic

This option offers the maker to select all leather or all plastic forearms and cuffs.
Leather may be a more comfortable option over the plastic version. If the Leather
option is chosen, then all templates must be rendered but saved as an SVG file.
To do this go to File>Export>Export as SVG. Name the file compatible with the
template such as “CuffLeatherTemplate” and save. For the leather option Cuff3,
UpperArm3 and LowerArm3 will not render as they are not needed in the leather
option

Handwidth

Measure the width of the recipient’s intact hand at the knuckles.

ArmLength

Arm length is typically chosen based on the recipient’s “good” arm—or it may be
purposely made shorter for easier maneuverability and better mechanical
advantages, but make sure to choose a value longer than the recipient’s residual.
The Wrap version is primarily meant for recipients with a residual longer than half
the recipient’s intact arm.

Forearm
Circumference

Measure the circumference of the forearm just below the elbow crease.

Bicep
Circumference

Measure the circumference of the bicep where the cuff will wrap around.

Padding
Thickness

Padding is not recommended for the leather version.

For the plastic version, padding is recommended to be inserted in the upper arm
area where the recipient’s forearm residual and bicep area will contact the
prosthetic. The more comfortable option is silicone sheeting —e.g.
https://amputeestore.com/pr ts/silipos-pr: re-relief-gel- ing?variant
14763009 — but the more expensive option.



https://amputeestore.com/products/silipos-pressure-relief-gel-padding?variant=4114763009
https://amputeestore.com/products/silipos-pressure-relief-gel-padding?variant=4114763009
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Closed cell neoprene is a less expensive but still a good option. Here are links to
a couple of these:

https://www.amazon.com/Insulation-Neoprene-Adhesive-Multi-Function-Soundpro
f/dp/BO8BRILF7BX

https://www.amazon.com/NATGAI-Neoprene-Adhesive-Multiple-Dimensions/dp/B0

7VY7SERP
2mm is th ical thickn for ing.

PalmBolt
Diameter

Bolts for the palm can be printed, however, we recommend small bolt sizes
(diameter 4mm or less) should be purchased as metal or nylon bolts to reduce the
chance of bolt breakage. Also, we recommend the sizes chosen to be in
proportion to the arm size, i.e. use small bolts for a small arm and a larger one for
larger arms.

ElbowBolt
Diameter

Bolts for the elbow can also be printed, however, we recommend small bolt sizes
(diameter 4mm or less) should be purchased as metal or nylon bolts to reduce the
chance of bolt breakage. Also we recommend the sizes chosen to be in
proportion to the arm size, i.e. use small bolts for a small arm and larger one for
larger arms.

RivetShaft
Diameter

Rivet shaft diameter only applies to the leather version and to how large the holes
should be in Cuff 1 and Cuff 2 as well as Arm1 and Arm2 parts. Rivet shafts come
in different sizes. An alternative to rivets are Chicago screw/post sets.

StrapWidth

Velcro Straps are required on the Cuffs and Forearms for both the leather and
plastic versions. Strap widths of 25 mm are typically used for larger sized arms
and 10mm for small sizes.

PencilHolder

A Pencil holder on the palm is an option and should be made with TPU.

(Paragraph deleted-redundant)

Table 1: OpenSCAD Options and Ranges (see note 1)

10

Parameter Range units Recipient Values



https://www.amazon.com/Insulation-Neoprene-Adhesive-Multi-Function-Soundproof/dp/B08R9LF7BX
https://www.amazon.com/Insulation-Neoprene-Adhesive-Multi-Function-Soundproof/dp/B08R9LF7BX
https://www.amazon.com/NATGAI-Neoprene-Adhesive-Multiple-Dimensions/dp/B07VY7SFRP
https://www.amazon.com/NATGAI-Neoprene-Adhesive-Multiple-Dimensions/dp/B07VY7SFRP
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Part

See separate list

n/a

Left or Right

Left or right

Leather or Plastic

Leather of Plastic

Handwidth 65 - 186 mm
ArmLength 141-564 mm
ForearmCircumference 135-542 mm
BicepCircumference 147-600 mm
PaddingThickness 0-10 mm
PalmBoltDiameter 4,6,0r8 mm
ElbowBoltDiameter 4,6,8,10,12or 14 mm
RivetShaftDiameter 24,28,3.1,4,50r6 mm
StrapWidth 10-60 mm
PencilHolder yes or no

Render all appropriate parts

Select each part in the Parts dropdown.Then Press Render.

o

G == W O = 3=

NOTE: The render button can take a long time for some parts (20 minutes or more).

Editor

STL

Save STL (exception—leather template). Export and save the stl files under a name that identifies
each part. For the CuffLeatherTemplate choose FILE->EXPORT->EXPORT As SVG

o

G = MW 0 ~ = =
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Section 2: 3D Printing of Necessary Parts

Table 2 shows all parts available for printing along with quantity required, material typically used, and
if supports (bed contact) are generally used. PETG is the material recommended for most of the
parts because of its strength and solvent resistance—other materials may be tried but we cannot
predict a good outcome. Use a suitable TPU for hinges and pencil the holder.

Printing Recommendations
Typical print temperature and print speed recommended for the material (PETG or TPU).
Infil should be 35% and of honeycomb geometry.

If you are using a printer with a 0.5mm nozzle, you may find a linewidth of 0.4mm works better for
some parts (e.g. latch).

We recommend the number of top and bottom layers to be 10 layers. The reason is that the 2mm
flexible plastic grid in the case of the plastic cuff has been engineered for flexibility and strength as a
solid device. If 10 layers for both and bottom layers are used, we can be certain the grid will be solid
but changes won’t be necessary for other parts. Make sure the gaps in the grid are open—if not you
may need to raise the z height so the bottom layer/layers will not be spread out which could cause
gaps to be fused closed. If gaps are closed, the grid may be inflexible.
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Note: All the parts are rendered from OpenSCAD in the orientation we think
is best for printing. Though, you may need to adjust the orientation based on

your particular printer.

A brim is recommended for the finger ends and phalanxes to enhance part stability during printing.

Printing the finger pieces can also benefit from
supports/scaffolding. Generally it is better to use a slicing
program that will let you manually place the scaffolding
for these parts. If you are having trouble with the fingers
coming loose from the base plate, try learning them back
to a 45 degree angle and adding more scaffolding. This
may add to the time to clean the parts, but can be more
reliable for some printers.

Note: If scaffolding is used, it is better to be manually added than be
auto-generated by the printing software. Auto-generated scaffolding can
block holes and make it very difficult to string the hand.

Make sure to review the scaffolding so it DOES NOT get created inside a
channel or hole where it can be very difficult to remove

Three orientations to print the Palm Top. The 45 degree angle was suggested by Krzysztof Grandys
and is my preferred orientation for best look and strength.
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If the leather option was chosen, open the SVG files (saved in the OpenSCAD procedure) in your
browser. We have found the Chrome browser opens with an accurate size representation so that
you can simply print out the template on paper. We have also used Safari to open the SVG file but
found it necessary to size the printing to match the holes in the Cuff, UpperArm and LowerArm
prints. Once an accurate template is printed, lay it out on the leather and cut the outline. Plan to
use the smoothest side of the leather in contact with the recipient’s skin for greater comfort. A
leather punch is recommended to make accurate holes in the leather where it will attach to the
plastic components. We also recommend ~4.5 oz leather (~1.8mm thick). It is the more expensive
option but we believe it to be more comfortable than the plastic. A website of one supplier of cowhide
leather is www.montanaleather.com

One choice that is not required in the OpenSCAD options is arm color. The recipient should be
consulted about their choice in color for their arm so the printer can purchase a filament color as
close as possible to the recipient’s choice. If a suitable color is not found, it is possible to use spray
paint to better match the recipient’'s choice. The arm may also be decorated according to the
recipient’s wishes.

Total printing time for all parts may be 30 to 40 hours. After each print, remove any support
structures and sand or file any rough edges or corners. Additional sanding or filing may be
necessary when fitting parts together during assembly. Printing several small parts in the same print
job will cut down on total print time.

TPU is required for hinges and the pencil holder. Hinges have been design
engineered to use a TPU of Shore A hardness range of 85A to 95A . ShoreA
hardness 85A is preferred but more difficult to print than 95A. The brand
NinjaFlex is the original material from a company called NinjaTek. They have
since come out with several other flexible filaments all with different
properties, so be sure to get the one with Shore A Hardness of 85A.
Likewise, FilaFlex is a company whose original product was Shore Hardness
82A. They have since come out with FilaFlex Medium which is Shore A
Hardness 95A. Shore A Hardness 95A will work for Kwawu 3.0 hinges but
since it is stiffer than ShoreA hardness of lesser values, it would be less
responsive.

For hinges, make sure the printed parts fit into their appropriate slots
snuggly, i.e. will not fall out and will fit into the slots without trimming. Since
printers can vary, it may be necessary to scale the print in your slicer to
obtain a proper fit.



http://www.montanaleather.com

Table 2: Printing the Parts

Kwawu Arm 3.0 Wrap Version

Parts Quantity Material Supports
Palm 1 PETG yes
PalmTop 1 PETG optional
WristButton 1 PETG no
WristCover 1 PETG no
Cuff1 1 PETG yes
Cuff2 1 PETG yes
Cuff3 Oor1 PETG no
CuffLeatherTemplate Oor1 n/a
UpperArm1 1 PETG optional
LowerArm1 1 PETG no
UpperArm2 1 PETG no
LowerArm2 1 PETG no
UpperArm3 1 PETG no
LowerArm3 1 PETG no
UpperArmLeatherTemplate Oor1 n/a
LowerArmLeatherTemplate Oor1 n/a
Ratchet 1 PETG yes
Latch 1 PETG no
LatchCover 1 PETG no
WristAttachment 1 PETG no
WristBolt 1 PETG no
PalmBolt Oor2 PETG/ no
metal/nylon
WristBoltPin 1 PETG
ElbowBolt1 Oor1 PETG/ no
metal/nylon
ElbowBolt2 Oor1 PETG/ no
metal/nylon
IndexFingerEnd 1 PETG optional
IndexFingerPhalanx 1 PETG optional
MiddleFingerEnd 1 PETG optional
MiddleFingerPhalanx 1 PETG optional
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PinkyFIngerEnd 1 PETG optional
PinkyFingerPhalanx 1 PETG optional
RingFingerEnd 1 PETG optional
RingFingerPhalanx 1 PETG optional
ThumbEnd 1 PETG optional
ThumbPhalanx 1 PETG optional
Tensioner 1 PETG no
WhippleTreePrimary 1 PETG no
WhippleTreeSecondary 1 PETG no
PencilHolder Oor1 TPU no
Hinges 1 set TPU no

Section 3: Kwawu 3 Assembly-Wrap Version

How does the Arm Work?

Familiarize yourself with the function of the arm prior to building. The fingers are supposed to
close with the thumb first and the pinky last. When the fingers close in order, you get the

16

precision of the thumb and index finger first, while the remaining fingers are still out of the way.

This enables you to pinch or to pick up finer objects. If you continue to close the grip the other

fingers engage as would happen around a bottle or baseball.

The wrist button allows the wrist to freely rotate when pressed and “lock” in place when

released. Different wrist positions are useful for different applications.

The latch allows the grip to stay closed tight with the elbow moving freely. With the latch open,
the grip opens and closes with the elbow movement. With the latch closed, the string is held as

the elbow closes. This allows the user to hold a grip while still using the elbow motion. An
example where the latch is useful is when the user needs to hold a spoon while eating or a
grabber bag while walking. Move the latch slider back to the open position to release the grip.
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Note: Assembly videos have been prepared and are supplemental or maybe used in place of
this document. See at www.onemonkclapping.com

Phase 1 : Preparation

e Gather Materials

e |dentify and Arrange Parts

e Prepare the Printed Parts
Phase 2 : Hand

e Assembling the Hand

e Stringing the Hand

e Tensioning
Phase 3: Forearm

e Assembling the Forearm

e Assemble the Cuff
Phase 4: Putting it all together

e Attaching Hand to Arm

e Assembling the Latch

e Final Tensioning and Knotting
Phase 5: Final Tests and Fitting

e Straps, Finger Tips, and Palm Grip

e Padding and Fitting


http://www.onemonkclapping.com
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Gather Materials

Tools needed for Assembly
We tried to keep the required tools list as short as possible.

Thick CA glue such as Super Glue for sealing the knots in the
fishing line and for assembling the forearm.

Two part epoxy is better to assemble arm pieces, if you print the
arm in two pieces.

Phillips head screwdriver to fit the Sheet metal screws (#4 pan head)

Hexagonal allen wrench or Robertson square head drive. Depends
if you use metal purchased bolts or the 3d printed bolts.

e Sharp knife or scissors to cut the fishing line.

Tools Recommended for Assembly
These tools will make your assembly easier and generally result in a better device.
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Small flat file , Small round file , Medium half round file
sanding blocks or sandpaper to clean printed parts.

Toothpick or similar disposable fine tip to help spread the glue.

Utility knife or razor to help clean parts. A sharp razor is helpful
to clean “stringing” off the flexible parts and is very useful to trim
the hinges.

A pair of needle nose pliers can come in handy, particularly
when removing scaffolding.

Galvanized Picture Hanging Wire and/or a T handle Ball End
Allen Wrench

Both are very useful in clearing the string holes in the fingers
and palm if they close up during 3-D printing. The wire helps
pass the string in difficult places. Galvanized wire comes in
many sizes at the local hardware store. It is generally stiff
enough to force through the holes to open them up.
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Plasti Dip - clear

We paint this on the fingertips and the entire palm grip area. This
creates a much better grip, than the plastic by itself. It is durable
when used with the primer.

A thread Tap tool is handy. You can always heat a metal bolt
and use it to clean the threads in the plastic but a tapping tool is
made to do this and would do a better job. You likely will only
need a few sizes which correspond to the size of your palm and
elbow bolts.

Parts and Supplies
These are the materials you will use for each build.

Dyneema fishing line—80 to 120 test strength Dyneema is the name of
material used in recommended fishing line. For a 100% size hand you will need
about 10 feet. Purchase extra to allow for adjustments in tensioning and
restringing of the hand. (e.g. brand names include Spiderwire or Hercules).

Steel rod of 2mm diameter.

2mm rods are available on Amazon.

https://www.amazon.com I BO7D2WSE2

Typical wire clothes hangers are suitable or hardware stores sell this diameter
steel.

To stabilize the latch mechanism you only need a short piece. To strengthen the
forearm you will need four pieces about 100mm each.

Self Adhesive Padding in areas intended to be in contact with the recipient’s
skin (cuff and forearm) is recommended. The thickness of this padding should
have already been designated in the OpenSCAD “padding thickness” choice
section. If the leather option is chosen, no padding is needed.

Silicone: https://amputeestore.com/products/silipos-pressure-relief-gel-padding
Neoprene:
https://www.amazon.com/Insulation-Neoprene-Adhesive-Multi-Function-Soundpr
00f/dp/BO8RIOLF7BX

or

Neoprene:
https://www.amazon.com/NATGAI-Neoprene-Adhesive-Multiple-Dimensions/dp/

St



https://www.amazon.com/gp/product/B07D2WSF29
https://amputeestore.com/products/silipos-pressure-relief-gel-padding
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BO7VY7SFRP

Velcro Straps —the width of these straps should have been already designated
in the OpenSCAD “StrapWidth” choice option. Generally, 8” to 12” long, 1” wide,
non-elastic (often sold as cable straps). For small arms you can use 1/2” wide

Palm bolts Cap Head It is recommended to use store bought nylon bolts
because they are lighter than metal bolts and more durable than the 3-D
printed ones.

The bolts need to match the thread size specified in the OpenSCAD. Most
hardware stores will carry these bolts.

Elbow Bolts round head - A nice smooth round head store bought nylon
bolt is the best option. When printing with PETG | have had good luck with
the printed elbow bolts. But they can break while tightening which can be
frustrating to get cleared out.

The bolts need to match the thread size specified in the OpenSCAD. Most
hardware stores will carry these bolts.

Sheet metal screws (#4 pan head) of appropriate length for attaching socket
wrist to Palm (1 ea.) and for attaching LatchCover to Upper Arm (1 ea.) The #4
size is US standard, outside the US it is a 3mm sheet metal screw.

ThreadLocker Blue Gel
Once you have assembled everything, it is recommended to put on the bolt
threads so they do not work loose. You can use glue if you do not have this.

Rivets and/or Chicago screw/post Applicable to the leather option only.

For smaller sizes, we prefer copper rivets. They are small and can be cut to
length. The down side is you can crush the plastic if you are not careful.
https://www.amazon.com/gp/product/BOSHMYMFWS

For larger sizes we prefer Chicago screws. They are reusable, but only come in
a limited number of lengths and diameters.

Make sure the correct diameter of the shaft is set in the OpenSCAD options



https://www.amazon.com/gp/product/B08HMYMFWS
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Leather We recommend ~4.5 oz leather (~1.8mm thick). It is the more
expensive option compared to plastic, but we believe it to be more comfortable
than the plastic. You can print the leather template SVG files on paper, and use
that to determine how much leather you will need.

A leather punch is recommended to make accurate holes in the leather where it
will attach to the plastic components. A website of one supplier of cowhide
leather is www.montanaleather.com

To determine which size and length to purchase for the elbow and palm
bolts, use the 3-D printed bolts and the parameters on OpenSCAD. It is
helpful to bring the sample 3-D printed bolts with you to the store.

Both metal and nylon bolts can be cut if they are too long and if you have the
proper tools.

Identify and Arrange Parts

4

|dentify the correct parts for
the fingers and palm and
arrange them in order.

2

The finger pieces have
numbers embossed in them.
These correspond to the
finger numbers 1 to 5 starting
with the thumb.
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The location of the number on
the fingers will verify that you
have a Right or Left Hand.

Right Hand Indesx
Finger End #2

Right Hand Index
Finger Phalyny #2

Prepare the Printed Parts

Thoroughly Remove the
Scaffolding

This is an important step. Make
sure you remove all scaffolding in
the corners and edges.
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Sand, File and Smooth
Parts

Sand, file and generally finish the
parts. If you oriented the finger
phalanx as suggested during the
printing process, you will need to
sand the curved back end of the
parts. The added supports and
spreading will mean the back is not
round.

Clean string channels

In smaller printed hands the holes
for the strings can close during the
printing process. Galvanized picture
wire is generally stiff enough to
force through the holes to open
them up.

You can also force the wire through
the opening, heat it with a solder

4 iron, and move it around to smooth
. the inside of the channels.




Clean the Palm and Elbow
threads

Using a metal bolt or a tap tool,try
screwing the bolts into just the
threaded part. The top of the
palmtop and the elbow have
threads matching what was set by
OpenSCAD.

You may need to heat the bolt to
help clean the plastic threads.
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Clean the wrist bolt threads

Try screwing the wrist bolt in the
forearm. Make sure it is smooth and
easy to tighten all the way.
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Clean wrist button mechanism
The wrist button is printed with very
tight tolerances. You will likely need
to sand the ratcheting part of the
wrist bolt to a smooth round finish.

Insert the wrist bolt from the inside
of the palm. Make sure it rotates
easily, yet is sung

Put the Wrist cover over the wrist
bolt, WITHOUT the WRIST
BUTTON. Make sure the wrist bolt
can rotate smoothly and easily yet
does not rattle.

Take the wrist bolt back out after
the test.

B. Hand Assembly

1. Gather all parts of the hand together. Each finger end and phalanx has a number that is
imprinted on it, i.e. 1=thumb, 2=index, 3=middle, 4=ring, and 5=pinky. Fit the pieces
together —all should fit and move without undo friction that might impede bending. It may be
necessary to use a file, utility knife, or sandpaper to facilitate finger movement. The
rectangular holes should also be free of burrs or print filament webbing.

2. Insert the TPU hinges in the slots between the finger ends and the finger phalanxes. Insert
other TPU hinges in the phalanx top and slide the ends into the slots in the palm.

3. Stringing the hand is fairly straightforward and much easier than previous Kwawu versions.
Figure 1 shows the fingers and the stringing route. Figure 1 along with Figure 2 show a right
hand strung appropriately. A left hand (not shown) would be the mirror image of these
figures.
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4. There is a structure at the end of each finger for tying a knot. Use Super glue to fix the knots
from slipping. Note that the long end of the secondary whippletree is toward the thumb and
String 1 from the thumb connects to it (Figure 2). String 2 connects index finger end to
middle finger end via the thumb end of the primary whippletree. Note the imprinted arrow on
the primary whippletree will point toward the thumb. String 3 connects the ring finger end to
pinky finger end via the end opposite the thumb end of primary whippletree.

5. Figure 2 shows shows how the whippletrees are connected to the fingers (Strings 1,2, and 3)
and the whippletrees to each other (String 4). String 5 connects to the center hole in the
Secondary Whippletree and extends to the Tensioner (Tensioner not shown). String 5 needs
to be long enough to reach from the secondary whippletree to the bicep areas of the

recipient’s arm. It is recommended to attach String 5 later in the assembly process (see

Latch Assembly Step 6).

™~

Figure 1: Stringing the Hand: Fingers
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Secondary
Whippletree
L .,:‘J:ﬂ. .

Figure 2: Stringing the Hand: Palm
As shown in Figure 2, with all fingers extended, the the Primary Whippletree should be close
to the area in the Palm where Strings 2 and 3 enter the palm area. When the Whippletrees
are tied together (String 4) and thumb extended, the thumb side of secondary whippletree
should be close to the palm area where String 1 enters the palm. This will give the
whippletrees adequate room to move when fingers and thumb are clenched.



10.
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WristBoltPin

WristAttachment

WristCover

WristBolt WristButton
Figure 3: Wrist Components

Figure 3 shows components in the wrist. To make sure parts will function properly when
assembled, first make sure that the WristButton and WristCover will fit over the WristBolt all
the way to the WristBolt pedestal and are able to turn freely. The WristCover was designed to
be a tight fit, so it may be necessary to grind/file the ID of the WristCover so that it will fit and
turn properly. Also the WristBolt must fit into the hole on the palm top and be able to turn
freely. Again, the ID of the Palm top hole may have to be expanded by filing/grinding.

Test the WristBolt to make sure it threads into the WristAttachment. Filing in the threads of
the bolt may be required to initially get the WristBolt fully engage in the WristAttachment
threads. The application of a dry lubricant to the threads will help to obtain a smooth turning
of the bolt into the WristAttachment. After obtaining smooth threading of the bolt into the
socket, remove the WristBolt from the WristAttachment.

Place the WristButton into the top of Palm cavity. While pushing the button, insert the
WristBolt into Palm cavity and push the threads out of the top opening. Then place the
WristCover over WristButton such that the wedge shaped structures will fit into the recesses
in the Palm.

Thread the WristBolt onto the WristAttachment until it is tight making sure the slots in the
WristAttachment are visible. Then loosen the WristAttachment until the first slot in the
WristAttachment lines up with the slot in the WristBolt. Insert the WristBoltPin in the slot to
lock the WristAttachment to the WristBolt.
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Forearm and Cuff Assembly Part 1
1. Arrange the plastic Cuff and Forearm pieces as shown in Figure 4. This figure shows a right
arm assembly. The left arm configuration would be the mirror image of this figure.
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Figure 4: Forearm and Cuff Part Layout

2. UpperArm1 connects with LowerArm1 and UpperArm2 connects with LowerArm2. However,
because the joint may tend to be weak point, reinforcement has been designed into the
assembly. Figure 5 shows where 2mm wire is designed to be inserted into these parts to
make them significantly stronger. Two wires per joint are required.

3. Figure 5 represents the the joint between the UpperArm and LowerArm. Measure the depth
of each hole and cut a 2mm wire to span the distance - do not take into account the
alignment peg in measurements. Insert the two wires into holes on one plastic brace -there
will be a significant length extending—then insert this end into the corresponding holes in the
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other arm brace. Slide it all the way including the Alignment peg into the LowerArm. If all fits
properly, use 2 part epoxy to permanently just UpperArm to LowerArm braces. Both Arm1
and Arm2 should have the wire inserts. This process applies to the leather option as well
exept of course there is no plastic grid to deal with.

Whire Insertion Poinks

Alignmant Peg

Figure 5: UpperArm to LowerArm Connection

4. This step applies to the plastic option: Use 2 part epoxy to attach Cuff2 to Cuff1 and
Cuff3 to Cuff 1—see orientation in Figure 4.

Similarly, attach UpperArm2 to UpperArm1 and UpperArm3 to UpperArm1.
Likewise, attach LowerArm2 to LowerArm1 and LowerArm3 to LowerArm1.

5. This applies to the Leather Option: Lay the three leather pieces (cut previously) flat with
the top smooth surface that will eventually be in the contact with the skin of the recipient.
Use Figure 4 to align the leather similar to the layout of the plastic parts and make sure holes
align properly. Verify the holes in the cuffs line up with the holes in the leather.

6. Leather Option: Attach the leather to the printed parts using Rivets or Chicago type
fasteners. Push the fasteners through the leather and plastic and seal from the plastic side.

D. Latch Assembly

1. Prepare to assemble the latch mechanism—Latch, LatchCover, Ratchet, and Tensioner onto

the UpperArm. See Figure 6.
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Tensioner

Ratchet
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Figure 6: Latch Mechanism

2. Cut a piece of 2mm wire/hanger to span from the hole in the UpperArm Latch recess,
through the Latch and into the hole in the LatchCover. The hole in the Latch may have to be
widened to be able to insert the wire—use appropriate sized drill bit if necessary. Insert the
wire in the Latch hole to act as an axel in the Latch and set the Latch with wire into the
forearm recess.

3. Place the LatchCover over the Latch making sure the wire is inserted in the hole supplied.
Use a #4 pan head sheet metal screw to attach the LatchCover to the forearm.

4. With the Latch pulled back (off position), place the Ratchet in place. Make sure the Latch will
engage in the Ratchet teeth when in the forward (on) position.



Kwawu Arm 3.0 Wrap Version 33

Insert the Tensioner in the slot in the side of the Ratchet (see Figure 6). It should fit in all
four of the possible orientations. Some trimming of the Tensioner may be required in certain
orientations.

Push one end of String 5 through the Egress Port in Arm1 (see Figure 7) then thread it into
the WristBolt and into the Palm cavity. Attach the string to the center hole of the Secondary
Whippletree as shown in Figure 2. This description is applicable to both Leather and Plastic
options.

Figure 7: Lower Arm Brace showing String 5 Egress and Forearm to Wrist Attach
Use sheet metal screws to attach the plastic LowerArm braces to the WristAttachment port
on the wrist. There are 2 holes in the WristAttachment for this. Use 2 part epoxy to help
secure the plastic or leather to the WristAttachment.

Cut String 5 such that it extends past the Ratchet on the forearm. Thread the free end of the
string up through the hole in the Ratchet as shown in Figure 6, then remove the Tensioner
from the Ratchet and tie it to the Tensioner through the center hole in its axel. Super glue
both knots in String 5. Wind string 5 around the Tensioner to tighten and reinsert the
Tensioner into the Ratchet slot.

The PalmCover can now be attached over the palm cavity by fastening it with 2 bolts
selected earlier. The Forearm and Hand Assembly is complete.

E. Cuff and Forearm Part 2

1.

Using Bolts previously selected, attach Cuff1 to the Ratchet/Latch side of UpperArm1 and
attach Cuff2 to the opposite side. It may be helpful to use an appropriate size tap to clean the
threads on the UpperArm.

Use three velcro straps having the width as chosen initially and thread it through the gaps
between the plastic or leather and through the attached loop at the velcro end. The straps
will allow the cuff and forearm to be tightened as necessary

Flex the cuff and verify finger movement. If String 5 is not tight enough, remove the
Tensioner from the Ratchet slot and wind the string tighter and place it back in the Ratchet
slot

F. Padding Install
Plastic Cuff:

1.

Plastic Cuff and Forearm: Silicone or Neoprene option—Cut three pieces of padding to fit on
the inside of the Cuff and Forearm parts. Peel the backing and apply it to the Cuff,
UpperArm and LowerArm.

Leather Cuff and Forearm— the leather option does not need padding.
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G. Final Comments
Optional
1. Plasti Dip is commonly used on fingers and palms to enhance the ability to pick and hold
things because it adds tackiness to the plastic fingers. Plasti Dip Primer is recommended
prior to painting with the Plasti Dip. The joints and strings in the fingers should not be
exposed to Plasti Dip.
2. Lee Tippy Nail’'s Gel Finger Tips can be purchased and placed over the ends of the plastic
fingers to enhance gripability

Final Testing
1. Exercise the wrist lock mechanism to make sure the hand can be turned 360 degrees and
can be locked at any selected location.
2. Exercise the latch mechanism. In the engaged position, the latch should lock the fingers in
position depending on the extent of elbow rotation.
3. With the latch in the engaged position, fingers should maintain their clutched position even
when the elbow is straightened,

Assembly is complete

Hurray!!!



